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Disclaimer

You can use SSL to secure parts of the communication with Sennheiser Control Cockpit service to
the client’s web browser.

SSL/TLS configuration is outside the scope of Sennheiser‘s support and the information of this
document is provided without warranty of any kind, whether expressed or implied.

To ensure the correct installation of security certificates, it is highly recommended to consult the IT
Security Manager responsible for the Public Key Infrastructure (PKI) within your company and the
provider of the respective certificate.

Introduction

Since the Sennheiser Control Cockpit is a web application, there is communication between the
client's web browser and the Control Cockpit application running on a server. This server and client
might be the same machine, but in most cases they are different machines.

The unsecured communication running through a network can be intercepted or manipulated, user
names or passwords might be intercepted by a third party. Therefore, Sennheiser strongly advises to
use the Sennheiser Control Cockpit over HTTPS.

This additional security might result in a slower performance. As with all security measures, it will not
guarantee security, but raises the barrier to attacks significantly.

Additionally, the involved systems should always be up to date and unique, strong passwords should
be used. Furthermore, common good practices for increasing network security should be applied.

General Information

Certificate signature types

Essentially, HTTPS is a certificate containing a public key of an asymmetric key pair and the cor-
responding private key that is stored in a protected data space. This certificate is kept within the
Microsoft Windows Certificate Store.

You can either get an official certificate, signed by a trusted Certificate Authority (CA) or create your
own self-signed certificate.

Authority-signed certificate (recommended)

A certificate that has been given out by an internal or public Certificate Authority can be used for
production servers. Browsers and clients will trust the certificate.

« If you are running your own Public Key Infrastructure (PKI) within your company, you can sign
the Sennheiser Control Cockpit HTTPS certificate from this internal Certificate Authority.
Company owned clients and web browsers will trust this certificate issuer. This is typically
applied for encrypted services which are only meant for company internal usage. Please con-
tact the operator of your Public Key Infrastructure for further assistance.

* You can also purchase a signed certificate from a public Certificate Authority. Common web
browsers and clients will trust those certificate issuers. This should typically apply if the
Sennheiser Control Cockpit can be accessed from not centrally managed clients, untrusted
networks or the Internet.
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Self-signed certificate (optional)

A self-signed certificate should only be used for testing purposes or internal servers. As the name
implies, these certificates have not been signed by a public, well-known Certificate Authority. There-
fore, the identity of the server using them is not trusted by clients.

Setup overview for HTTPS run

To set up the Sennheiser Control Cockpit for HTTPS the following main steps have to be made:

1. “Create or request a certificate”

2. “Bind the certificate to the connection”

3. “Configure the Control Cockpit to use HTTPS”

4. “Restart the Control Cockpit and log on”

“Optional: Open a port in your firewall and trust the certificate on the client(s)”

Requirements
The following requirements must be fulfilled for the next steps:

» Sennheiser Control Cockpit Software version 6.0.0 or higher is installed to the default location
with default settings

» The machine intended for the application is running at least the operating system Microsoft
Windows 10 or Microsoft Windows Server 2019

» Accessible administrative rights for the machine

Step-by-step Guide

In this document you will find the following paragraph formats to help you read and understand the
guide:

m This is a note

> This is a task

v This is an intermediate result

M This is a final result

= This is the further necessary step
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1. Create or request a certificate
Depending on the desired certificate type, please follow the instructions in the respective chapter:
“Create an authority-signed certificate”

“Create a self-signed certificate”

For production servers it is strongly recommended to use a certificate that has been issued
by an internal or public Certificate Authority.

Create an authority-signed certificate

In order to use authority-signed certificate you have to create a Certificate Signing Request (CSR)
and send it to the Certificate Authority. Depending on your Certificate Authority there might be a
manual, script or even application to create such a request.

Due to the dependency on the Certificate Authority and your network setup, please refer to
the Certificate Authority or your IT department for further assistance.

To create a Certificate Signing Request: File Action View Favorites Window Help
D> Startthe Microsoft Management Con- * L= Cri+N
sole by clicking the Windows logo in your = Open... Ctrl+0
task bar. v Save Ctrl+S
> Type mmc.exe and run this command as an save As..
administrator. Add/Remove Snap-in... Ctrl+M
> Addthe Certificates Snap-InviaFile\
Add/Remove Snap-in.... Available snap-ins:
> Choose the Certificates for the local com- Snap-n Vendar 2
puter. = ActiveX Control Microsoft Cor...

Aumorization Manager Microsoft Caor...
Microsoft Cor...
e Component Services Microsoft Cor...

D> Select the Personal node of the certificates
inside the new tree view in the left panel of
the Microsoft Management Console.

Console Root.

> With a right click select A11 Tasks and 0 G i
then Advanced Operations and click

Trus Find Certificates... |
Ente

Object Type
7 Certificates

Cre a_te CU Stom Req u e S_t. 2 sl All Tasks > Find Centificates... ‘
Acti View > Request New Certificate..
. Trus lew Window from Here 'mport...
> Choose to Proceed without enrollment [ um Moimietond S
Thir New Taskpad View.. Advanced Operations > Create Custom Request...

policy, unless otherwise noted by your
administrator.

=
iy Refresh Enroll On Behalf Of...

o B Manage Enrollment Policie
Oth port List. ~ Manage Enrollment Policied

In order to match specific requirements, please refer to the Certificate Authority or your IT
department before taking the next steps.

> Click on: Custom request 1) STATUS: Available Details}
. Next, if no specific requirements are Theé:;\‘:u:;r;iopﬁonsdascribethausasandva\iaityperiodmatapprymmistypaofcertmicate:
needed (default settings will be applied) e
e Properties under the dropdown LS
Details to meet your specific require-
ments within the tabs: Centficate Properties <

e General

General Subject Extensions Private Key

. S u b J ect The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that
. Extensions can be used in a certificate.
Subject of certificate
° Private Ke \ The user or computer that is receiving the certificate
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To meet your specific requirements you will find the following attributes under the respective tabs:

General

For the field "Friendly name" it is recommended to use
SennheiserControlCockpitCertificate.
Any further settings depend on your chosen Cer-
tificate Authority.

Subject

In the Subject tab you have the Subject name
box containing the following fields:

« Common Name (CN)-Thisisthe server‘s fully
qualified domain name or the IP address or
short name of an internal server.

e Organization (O) - This is the name of
your company or organization.

e Organizational Unit (OU) - The
department or unit of your company, e.g.:
Information Technology.

e Locality (L) - The city where your orga-
nization is located or has its legal location.

« State (S) - The name of the state or prov-
ince your organization is based. Please do
not use an abbreviation but the full name.

e Country (C) - This is the country you are
located in, written in the two letter ISO
country code. For example, these codes are
US for United States, GB for Great Britain
(UK), DE for Germany, FR for France or ES
for Spain.

Inthe Alternative name box, the following field
is of particular interest:

« DNS - This field allows giving all different
names of you server, e.g. "'myHostname",
"127.0.0.1", "myHostname.internal.
myCompany .com". Newer browser versions
rely on this so called Subject Alternative
Name (SAN) attribute of the certificate.

Extensions

If you want to widen the possible usage of the cer-
tificate, then uncheck "Make the Extended Key
Usage critical" withinthe Extensions tab.

Private Key

On the Private Key tab you can choose some
encryption options, e. g.:
e Key Size:
it is recommended to use 2048 bits).
» Provider:
For the choice of the Cryptographic

Service Provider the default RSA should be
suitable.

> Click on Apply » OK» Next to close the set-
tings and to create the request file.

M You have successfully created a request file
(*.req).

Certificate Properties X

General Subject Extensions Private Key
A friendly name and description will make it easier to identify and use a certificate.
Friendly name:

Description:

Tab “General®

General Subject  Extensions  Private Key

The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that
can be used in a certificate.

Subject of certificate

The user or computer that is receiving the certificate

Subject name:
Type:
Common name v Add >
Value:
|:|_a e < Remove
Alternative name:

Type:

Add >

< Remove

Tab “Subject”

Certificate Properties

General Subject Extensions  pPrivate Key

The following are the certificate extensions for this certificate type.

Key usage v
Extended Key Usage (application policies) b4
Basic constraints v
Include Symmetric algorithm w

Tab “Extensions®

Key usage
The key usage extension describes the purpose of a certificate.
Available options: Selected options:
CRL signing

Data encipherment
Decipher only

Digital signature Add >
Encipher only
Key agreement < Remove

Key certificate signing
Key encipherment
Mon repudiation

Make these key usages critical

Unchecking “critical key usage“

General Subject Extensions Private Key
LCryptegraphic Service Provider ivi
Key options b4
Select Hash Algorithm v
Select Signature Format v

Tab “Private Key*
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The generated file includes a text containing a [----- BEGIN NEW CERTIFICATE REQUEST--——-

chunk of characters between AR ET Y (A AR AR AR T Mt Ml bt Mat
HHELL] R R R LR LETARCES LR LT FRUMEE

----- BEGIN NEW CERTIFICATE REQUEST----- ML RO SERR A UG | M A
d | h i LA TR T FTE Wb Ha 'l (X NI
an L} ] FiED | Pl DTUFRLI BRI PARBHHER RN N
[T Tl L Ll LRLELLL LELERE LULTELT, Wik i Wi LELLT]
----- END NEW CERTIFICATE REQUEST----- AT e A AR e R
) R T AT {h (LR LT | IRLIUEE LR PR
i L RIS 1R " LECL LI LUEETIEL R AR L Il|l|\ LEDULTR R

> Provide the generated request file or its con- KT

tent to the Certificate Authority. [z END) NER CERTT FICATE REQUEST o
Example of the generated request file

v You will receive a certificate from the Certifi-

cate Authority. . Certificate 4
D> Install the received certificate into the certifi- | ganersl Detsils | Certification Path

cation store LocalMachine\My.

Show: | <all> w

¥ In the detailed properties of the certificate

you will find a Thumbprint. Field Value ~

. epe BPUb"CkEY parameters

> Copy the Thumbprint of the certificate for the 5] Enhanced Key Usage T

next step. @Subjectl(eqluI Identifier iR RREETE B RIS S

X . .ﬂ.l.nhorit\-I Key Identifier cw [ i e TS,

= Next step: 2. Bind the certificate to the con- [ ssuer Alternative Name e . A g | S 4

nection. /55 Subject Alternative Name e 7] p———

W

\:.u-:-.--u ke wid

Create a self-signed certificate

Thumbprint of the certificate

Depending on your network settings you will have to use a different DNS Name and/or IP.
Please make sure that you are aware of additional parameters (e. g. -KeyAlgorithm and
-KeyLength) to adjust the command according to your personal requirements.

For -KeylLength itis recommended to use at least a 2048 bit key length.

For more information about this command and its parameters, please refer to:
Microsoft | Windows IT Pro Center

To create a self-signed certificate on a Windows 10 machine:

> Run the Windows PowerShell as administrator on the particular machine to host the Sennheiser
Control Cockpit.

Store your private keys in a safe place and never disclose them. Since this certificate con-
tains a private key, it should not leave your machine.

> Create a certificate with the following command by additionally adding your private key:

EX Administrator: Windows PowerShell - [m] X

New-SelfSignedCertificate -DnsName
"myHostname", "127.0.0.1",
"myHostname.internal.myCompany.
com"-CertStorelLocation
"cert:\LocalMachine\My" -FriendlyName
"SennheiserControlCockpitCertificate"

v A new Thumbprint will be given back by the Self-signed certificate and thumbprint
reply of the command.

Copy the Thumbprint of the certificate.

Trust this certificate later in your browser when using a self-signed certificate.

You have successfully created a self-signed certificate.

9 ® Vv Vv

Next step: 2. Bind the certificate to the connection
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2. Bind the certificate to the connection

The certificate received in step 1 has to be bound to the connection of the Sennheiser Control
Cockpit. To identify the certificate, its hash value has to be passed to the command. This hash is the
<<<THUMBPRINT>>>,

m If you are using another port than 443, please change the port number accordingly.

To bind the certificate:
> Alter the following command accordingly and enter it into the command line:

netsh http add sslcert ipport=0.0.0.0:443 certhash=<<<THUMBPRINT>>>
appid={6e57d14f-84f5-44£3-9b79-f04ecf2a5362}

m If the command does not work within a line, try to write the command in individual lines:

netsh

http

add sslcert ipport=0.0.0.0:443 certhash=<<<THUMBPRINT>>>
appid={6e57d14f-84f5-44£3-9b79-f04ecf2a5362}

M You have successfully bound the certificate.

= Next step: “Configure the Control Cockpit to use HTTPS”

3. Configure the Control Cockpit to use HTTPS

To use the Sennheiser Control Cockpit via HTTPS and to redirect HTTP traffic to https the config
file has to be extended by three additional parameters (secureServerPort, enableHttps and
certificateCommonName).

m If you are using another port than 443, please change the port number accordingly.

To configure the Control Cockpit:

> Open custom.configin a text editor under:
C:\Users\Public\Documents\Sennheiser\Sennheiser Control Cockpit\
config\custom.config.json

> Search for the JSON tag "hostingSettings"

> Edit the three parameters secureServerPort, enableHttps and
certificateCommonName as shown in the following example:

{
"hostingSettings": {
"secureServerPort": 443,
"enableHttps": true,
"certificateCommonName": "myHostname.internal.myCompany.com"
1.
}

M You have successfully configured the Control Cockpit to use https.

= Next step: “Restart the Control Cockpit and log on”
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4. Restart the Control Cockpit and log on

> Restart the Sennheiser Control Cockpit and try to log on.

m If you have any issues accessing the website, proceed with the optional step:
“Optional: Open a port in your firewall and trust the certificate on the client(s)”

M You are successfully running Sennheiser Control Cockpit over HTTPS.

Optional: Open a port in your firewall and trust the certificate
on the client(s)

If you are accessing from a remote machine to the server running the Sennheiser Control Cockpit,
you might have to open the incoming port 443 on the server‘s firewall.

Exported and distributed certificates should never contain a Private Key! For managing
your certificate store you can use the Microsoft Management Console that was also
used in step 1: “Create an authority-signed certificate®

To open a port when using the Windows Defender Firewall:

> copythe ControlCockpit WebUI inthe Inbound Rules
> renameitto ControlCockpit Secure WebUI

> change the local port to 443.

Depending on the certificate used, a warning may appear when logging in to the Sennheiser
Control Cockpit website that the certificate is not secured.

To trust the certificate on the clients:

> Click on "Trust this certificate" in your browser or deploy an exported version of your certificate
tothe Trusted Root Certification Authorities node of your certificate store.

M You have successfully changed the port and the certificate trust settings.

Additional Considerations

Certificates have a limited lifetime, i. e. they are valid from a certain point in time until another date.
The issuer of a certificate defines its lifetime.

For Windows 10 this lifetime is typically 1 year if not otherwise specified. This means that the certifi-
cate has to be renewed after a year.

Therefore, you might want to consider setting up a Windows Domain with a Windows Certificate
Service.
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